
 
 
 

 
 
 

GPS Cockpit 
 

A description of Vincotech’s Windows™ Software 
for visualizing and analyzing positioning data 

 
User’s Manual 

 
Version 3.1 

Software Revision 03 
 
 

 
   



  

 

Revision History 
 
Rev. Date Description 
1.0 01-20-04 First release 
2.0 03-12-07 Completely re-worked version; new description; new design 
2.1 07-09-07 Added newly integrated features; release of new Cockpit 
3.0 06-30-08 Adaptation to Vincotech, new features, correct support of A1082-A 
3.1 09-02-08 Support of TTFF measurements; creation of Google Earth overlay 

out of NMEA 
 mm-dd-yy  
 

V3.1 - 09/08 User’s Manual Page 2 of 25

 



  

 

Disclaimer 
 
THIS DOCUMENT CONTAINS PROPRIETARY INFORMATION OF VINCOTECH 
GMBH. IT MAY NOT BE COPIED OR TRANSMITTED BY ANY MEANS, PASSED 
TO OTHERS, OR STORED IN ANY RETRIEVAL SYSTEM OR MEDIA, WITHOUT 
PRIOR CONSENT OF VINCOTECH OR ITS AUTHORIZED AGENTS. 
 
THE INFORMATION IN THIS DOCUMENT IS, TO THE BEST OF OUR 
KNOWLEDGE, ENTIRELY CORRECT. HOWEVER, VINCOTECH CAN NEITHER 
ACCEPT LIABILITY FOR ANY INACCURACIES, OR THE CONSEQUENCES 
THEREOF, NOR FOR ANY LIABILITY ARISING FROM THE USE OR 
APPLICATION OF ANY CIRCUIT, PRODUCT, OR EXAMPLE SHOWN IN THE 
DOCUMENT. 
 
THE PRODUCT (HARD- AND SOFTWARE) DESCRIBED IN THIS DOCUMEN-
TATION IS NOT AUTHORIZED FOR USE IN LIFE SUPPORT DEVICES OR 
SYSTEMS WITHOUT THE EXPRESS WRITTEN APPROVAL OF VINCOTECH. 
 
THIS DOCUMENT MAY PROVIDE LINKS TO OTHER WORLD WIDE WEB SITES 
OR RESOURCES. BECAUSE VINCOTECH HAS NO CONTROL OVER SUCH 
SITES AND RESOURCES, VINCOTECH SHALL NOT BE RESPONSIBLE FOR 
THE AVAILABILITY OF SUCH EXTERNAL SITES OR RESOURCES, AND DOES 
NOT ENDORSE AND IS NOT RESPONSIBLE OR LIABLE FOR ANY CONTENT, 
ADVERTISING, PRODUCTS, OR OTHER MATERIALS ON OR AVAILABLE 
FROM SUCH SITES OR RESOURCES. VINCOTECH SHALL NOT BE 
RESPONSIBLE OR LIABLE, DIRECTLY OR INDIRECTLY, FOR ANY DAMAGE 
OR LOSS CAUSED OR ALLEGED TO BE CAUSED BY OR IN CONNECTION 
WITH USE OF OR RELIANCE ON ANY SUCH CONTENT, GOODS OR 
SERVICES AVAILABLE ON OR THROUGH ANY SUCH SITE OR RESOURCE. 
 
VINCOTECH RESERVES THE RIGHT TO CHANGE, MODIFY, OR IMPROVE 
THIS DOCUMENT OR THE PRODUCT DESCRIBED HEREIN, AS SEEN FIT BY 
VINCOTECH WITHOUT FURTHER NOTICE. 
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1 Introduction 
Welcome to GPS Cockpit, Vincotech’s user-friendly NMEA sentence interpreter 
program for Windows operating systems. GPS Cockpit allows a quick glance at 
GPS data, monitors and logs these data, displays them in a graphical way and even 
provides statistical information. GPS Cockpit “understands” the following NMEA 
sentences: 
 

• RMC - Recommended Minimum Specific GPS Data 
• GGA – Global Positioning System Fix Data 
• GSV – GPS Satellites in View 
• VTG – Course over Ground and Ground Speed 
• GSA – GNSS DOP and Active Satellites 

 
So in order to interpret these data, the according NMEA sentences have to be 
switched on within the GPS module. Of course, GPS Cockpit works best with Vin-
cotech’s positioning products, the GPS modules A1080-A, A1082-A, A1084-A, 
A1084-B, A1088-A, A1035-D, A1035-E and new ones that will be launched in the 
future, but can also be used with any other GPS modules providing NMEA informa-
tion. 
 

 
 

Figure 1: Overview 
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2 General Information 
2.1 System Requirements 
GPS Cockpit was designed to work with the operating systems Windows Vista, 
Windows XP, and Windows 2000. The resolution of the graphic card should be 
32bit. 
 
2.2 Highlights 
• Only requires the GPSCockpit.exe and the *.chm files for getting started   
• Simply connect to the GPS receiver by using the USB or RS232 port  
• Recorded NMEA data can be used instead of the GPS receiver for simulation  
• Following general GPS information can be read  

o Latitude 
o Longitude 
o Altitude 
o GPS Quality (fix availability) 
o Fix mode 
o UTC time 
o Sync PC time (synchronize your PC time) 

• Statistical information in graphical representation  
o Signal Quality 
o Azimuth/Elevation 
o Terminal program for monitoring NMEA data 
o Precision, Deviation, Evaluation 

• TTFF statistic tool 
• Creation of Google Earth Overlay 
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3 Getting Started 
3.1 Installation 
In order to install GPS Cockpit you just need to copy the two files 
 
• GPSC 3.00.exe 
• GPSC.INI 
• Cockpit_help.chm 
 
into a directory of your choice. You can create a shortcut to the executable in the 
standard way and place this shortcut on your desktop or your program folder. 
 
Your preferences will be stored in GPSC.INI. It will be created if the file does not 
exist in the execution directory of the program. You can copy this file to use your 
preferences in other directory or computer. 
 
Note: The help file will only work if the above mentioned files are copied to the local 
disk, not to any network drives (Microsoft security issue). 
 
3.2 First Touch 
After installation you can simply start GPS Cockpit by either double-clicking the ex-
ecutable itself or using a shortcut. The GPS Cockpit main window will pop up. 
 

 
 

Figure 2: Start-up window 
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In order to work with the NMEA data provided by a GPS receiver, you need to con-
nect this receiver to your computer – either using the USB interface for e.g. Vin-
cotech’s EVA1080-A, EVA1082A, or EVA1088-A or a COM port for e.g. the 
EVA1035-D or the EVA1035-E. For details on the connection and a correct set-up, 
please refer to the according manuals. 
 
Now you need to activate the correct port within GPS Cockpit. You can do this by 
either selecting “Port Number” in the “Settings” menu item or by simply clicking the 
“Connect” button. In any case, the following window will appear: 
 

 
 

Figure 3: Serial communication window - blank 
 
Choose the COM port to which the GPS receiver was connected, in our example 
COM11, set the baud rate (the default is 4800), and activate “NMEA Terminal” 
(On/Off), then click on “OK”: 
 

 
 

Figure 4: Serial communication window - selection 
 
The connection is established now and you can open a terminal window to see 
NMEA sentences by using the “NMEA Terminal” button. You should then see mes-
sages like this: 
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Figure 5: Terminal window with messages 
 
Now you can start using all the other windows and features of GPS Cockpit. 
 
3.3 Status Bar 
The status bar is giving you a quick overview on the mode of the survey window, 
the UTC date and time, the fix status and record mode (on or off), as shown here: 
 

 
 

Figure 6: Status bar 
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3.4 GPS Cockpit Window Menu 
The GPS Cockpit window menu consists of the items File, Settings, Tools, Window 
and Help. 
 

 
 

Figure 7: Menu items 
 
3.4.1 Window Menu “File” 
The “file” menu allows to play NMEA files, to record them, to stop recording and 
playing and to define a speed for playing the NMEAs. Using “Send file” one can 
transmit complete files (e.g. almanac and ephemeris data to a GPS module). And 
finally, one can exit GPS Cockpit. 
 

 
 

Figure 8: Sub-menu “File” 
 
3.4.2 Window Menu “Settings” 
With the „Settings“ menu, one can change general port settings, disconnect, launch 
a window for programming keys, set SNR value levels and General setting. 
 

 
 

Figure 9: Sub-menu “Settings” 
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Setting the SNR level will affect two windows, the „Signal Quality“ window, where 
signals below this threshold that are in use for calculating a fix will switch from a 
blue color to yellow color, and the „Sky View“ window, where only satellites with a 
CN0 above this value will be used for drawing the physical mask angle. Please note 
that the setting of this value has no effect at all on the satellites used for calculating 
a fix! 
 
With general settings one can define if the metric or imperial system is used for 
measurements and if degrees and minutes or only degrees (always with according 
decimals) will be used. 
 
3.4.3 Window Menu “Tools” 
The “Tools” menu gives access to two functions: creating a Google Earth overlay 
out of recorded NMEA data and doing time-to-first-fix (TTFF) measurements. 
 

 
 

Figure 10: Sub-menu “Tools” 
 
3.4.4 Window Menu “Window” 
The “Window” menu allows arranging the open or minimized windows within GPS 
Cockpit. 
 

 
 

Figure 11: Sub-menu “Window” 
 

V3.1 - 09/08 User’s Manual Page 11 of 25

 



  

 

3.4.5 Window Menu “Help” 
Using the “Help” menu one can open the integrated help manual (similar to this 
manual), get version information, open a link to our homepage or send us an email. 
  

 
 

Figure 12: Sub-menu “Help” 
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4 GPS Cockpit Windows  
4.1 Terminal Windows 
4.1.1 General Functions 
GPS Cockpit offers two terminal windows, the first window for the NMEA data, the 
second window e.g. for debug data or the NMEA data of a second receiver. The 
NMEA terminal window will open when the 

NMEA Terminal button   
 
is clicked. If you did connect already to a COM port with a GPS receiver, you will 
see the NMEA data. If you did not connect before, you need to connect using the 

COM port connection button . 
 
4.1.2 Commands in NMEA Terminal Window 
In addition to that the NMEA terminal allows the programming of commands to but-
tons. In order to do so, please follow this sequence: 
 
(1) Click the “Key Pad” selection in the “Settings” menu. 
 

 
 

Figure 13: Setting window – key pad command 
 
(2) Select the key, enter a button description (caption), enter the command se-

quence, and click OK. 
 

 
 

Figure 14: Key pad dialog 
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Afterwards, the commands will be available at a click on the according button. They 
are transmitted to the connected receiver. 
  

 
 

Figure 15: Issue command 
 
You can also use the command line to enter commands manually. The list box will 
show the recently used commands. As some receivers need a checksum, you can 
append it by activating the (Checksum) control. 
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4.2 Satellite Signals Window 
The satellite signal window displays the signal to noise ratio or carrier to noise 
(SNR or CN0, respectively) values of the satellites tracked by the GPS receiver and 
reported in the GSV NMEA sentence. Therefore this sentence has to be switched 
on. A typical situation might look like this: 
 

 
 

Figure 16: Signal quality window 
 
The numbers 13, 25, 4, etc. in the status area at the bottom represent the satellite 
numbers or their Pseudo Random Noise numbers. The numbers at the top of the 
signal quality bars display the current C/N0 value in dB/Hz. Values you can observe 
with Vincotech GPS modules range from 15dB/Hz to 55dB/Hz. 
 
A blue color or yellow color means that this satellite is used for calculating a fix, a 
grey color means that it is as “seen”, but not used. Blue means that the CN/0 value 
is above the defined minimum threshold, yellow means below. 
 
By doing a right click in the satellite signal window, you can enter the “SNR level” 
window for the satellite signals by choosing “Min. valid threshold”. You can enter 
this menu by using the “Settings”, too. 
                                                                 

 
 

Figure 17: SNR level window 
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4.3 Sky View Window 
The sky view window allows you to see the satellite positions in the sky directly. 
The satellite numbers (or their PRN numbers) can be viewed along with the azimuth 
and elevation values of each satellite, the satellite trails and the physical mask an-
gle. To enable or disable features, a right click will give you the following menu 
where you can choose different options. 
 

 
 

Figure 18: Sky view window and properties 
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4.4  Survey Window 
The survey window allows to monitor and to analyze the quality, accuracy and 
standard deviation of fixes for latitude, longitude and altitude. The window is divided 
into three sub-windows, an altitude window, a position window and a data window. 
The data window itself is divided in four sub-windows, a “Precision”, a ”Deviation”, 
and an “Evaluation” window. 
 
In the position window one can enter sub-menus doing a right-click with the mouse 
as shown in the following picture. 
 

 
 

Figure 19: Survey window 
 
Selecting zoom one can choose between automatic mode or zoom factors between 
25 and 400%. For plot mode either a line or points are available. Enabling the 
sigma ellipse, the position window will show in addition the area defining the stan-
dard deviation of the fixes. And with pinpoint, the center of the window can be de-
fined. 
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With a left-click measurement of distance can be done, the first click setting the ori-
gin. While dragging the mouse pointer within the picture the distance is shown in 
the right bottom corner. A second left-click will delete this origin again. 
 

 
 

Figure 20: Distance measuring in the survey window 
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5 GPS Cockpit Recording 
GPS Cockpit allows the logging (or recording) of data into a file. Data logging is 
started via a sub-menu in the NMEA Terminal window. The sub-menu is entered by 
doing a right-hand click within this window. Just click on “Start Log” to start data 
logging. 
 

  
 

Figure 21: Data logging sub-menu “Start Log” 
 

After starting a log a standard “Save As” menu will appear. Here you can enter file 
location and name. In order to stop the log, proceed as before and click on “Stop 
Log”. 
 

 
 

Figure 22: Data logging sub-menu “Stop Log” 
 
In order to this, you can also you the buttons in the GPS Cockpit menu. 
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6 GPS Cockpit Tools 
6.1 Convert NMEA to KML 
With the menu item “Convert NMEA to KML” one can create an overlay for Google 
Earth. Doing this, recorded positions can be displayed in Google Earth then auto-
matically. 
 

 
 

Figure 23: Tools window – convert NMEA to KML command 
 
When selecting this command the following the following dialog will appear: 
 

 
 

Figure 24: NMEA to KML dialog 
 
After clicking “OK” the KML file will be created. If the “Start Google Earth” selection 
was enabled and Google Earth is installed, it will be started automatically. 
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6.2 Time To First Fix Test 
With the menu item “ Time To First Fix Test” measurement of the time to first fix of 
different modules can be done. The tool allows doing different types of tests (cold, 
warm, hot starts), along with the selection of the module type, setting of time-outs, 
defining the number of tests and logging the NMEA data. To initiate the dialog one 
has to select the Time To First Fix  
 

 
 

Figure 25: Tools window – time to first fix test command 
 
When selecting this command the following the following dialog will appear: 
 

 
 

Figure 26: Time To First Fix dialog 
 
After defining your configuration you can start the test. A single as well as the com-
plete test can be interrupted at any time. At the end you can create a test report that 
itself can be exported as a file in CSV format. 
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Figure 27: Time To First Fix results 
 

 
 

Figure 28: Time To First Fix report 
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7 Distribution  
Vincotech grants the right to freely distribute GPS Cockpit along with its documen-
tation in its original version in electronic format to everyone. GPS Cockpit is no 
commercial product, therefore any form of charging or requesting donations is ex-
plicitly not allowed. As this product is freely available, there is no technical support 
provided for this product 
 
 
 

 
 

V3.1 - 09/08 User’s Manual Page 23 of 25

 



  

 

8 Related Information 
8.1 Contact 
This manual was created with due diligence. We hope that it will be helpful to the 
user to get the most out of the GPS module. 
 
Anyway, inputs about errors or mistakable verbalizations and comments or propos-
als to Vincotech in Munich, Germany, for further improvements are highly appreci-
ated. 
 
Vincotech GmbH 
Bibergerstr. 93 
82008 Unterhaching (Munich) 
Germany 
 
Tel.: +49 89 8780 67 0 
Fax: +49 89 8780 67 351 
gps@vincotech.com
www.vincotech.com/gps 
 
Further contact addresses: 
info.gps@vincotech.com
support.gps@vincotech.com
sales.gps@vincotech.com
 
8.2 Related Documents 
Related documents are all Vincotech GPS receiver or smart antenna manuals, es-
pecially the firmware manuals. In addition, useful information is included in the 
manuals for the different evaluation kits.
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